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Chapter 140

Tests for the Ratio of
Two Within-Subject
Variances in a 2×2M
Replicated CrossOver Design
Introduction
This procedure calculates power and sample size of inequality tests of within-subject variabilities from a 2×2M
replicated cross-over design. This routine deals with the case in which the statistical hypotheses are expressed in
terms of the ratio of the within-subject variances.
This design is used to compare two treatments which are administered to subjects in different orders. It has two
treatment sequences. Here, M is the number of times a particular treatment is received by a subject. For example, if
M = 2, the design is a 2×4 cross-over. The two sequences would often be
sequence 1: R T R T
sequence 2: T R T R
It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout
period between measurements.

Technical Details
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018).
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑙𝑙 is the response in the ith sequence (i = 1, 2), jth subject (j = 1, …, Ni), kth treatment (k = T, C), and lth
replicate (l = 1, ..., M). The mixed effect model analyzed in this procedure is
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑘𝑘 + 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖

where 𝜇𝜇𝑘𝑘 is the kth treatment effect, 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 is the fixed effect of the lth replicate on treatment k in the ith sequence, 𝑆𝑆𝑖𝑖𝑖𝑖1
and 𝑆𝑆𝑖𝑖𝑖𝑖2 are random effects of the ijth subject, and 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 is the within-subject error term which is normally distributed
with mean 0 and variance 𝑉𝑉𝑖𝑖 .
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Unbiased estimators of these variances are found after applying an orthogonal transformation matrix P to the x’s as
follows
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑃𝑃′𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

2
.
where P is an m × m matrix such that 𝑃𝑃′𝑃𝑃 is diagonal and var�𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 � = 𝜎𝜎𝑊𝑊𝑊𝑊

For example, in a 2×4 cross-over design the z’s become
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖1 =

and

𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖2 =

𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2
= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .
2
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2

In this case, the within-subject variances are estimated as

and

√2

2

= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .

𝑁𝑁𝑖𝑖

𝑀𝑀

1
2
𝑉𝑉�𝑇𝑇 =
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝑇𝑇𝑇𝑇 �
(𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1)
𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1
2

𝑁𝑁𝑖𝑖

𝑀𝑀

1
2
𝑉𝑉�𝐶𝐶 =
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝐶𝐶𝐶𝐶 �
(𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1)
𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1

Testing Inequality
The following hypotheses are usually used to test for inequality
𝜎𝜎²ᴡᴛ
𝜎𝜎²ᴡᴛ
= 1 versus 𝐻𝐻𝐴𝐴 :
≠ 1.
𝜎𝜎²ᴡᴄ
𝜎𝜎²ᴡᴄ
The test statistic used to test this hypothesis is 𝑇𝑇 = (𝑉𝑉�𝑇𝑇 /𝑉𝑉�𝐶𝐶 ).
𝐻𝐻0 :

Upon making the usual normality assumptions, T is distributed as an 𝐹𝐹𝑑𝑑 ,𝑑𝑑 random variable where
𝑑𝑑 = (𝑁𝑁1 + 𝑁𝑁2 − 2)(𝑀𝑀 − 1).

Hence the null hypothesis is rejected if 𝑇𝑇 < 𝐹𝐹𝛼𝛼/2,𝑑𝑑,𝑑𝑑 or 𝑇𝑇 > 𝐹𝐹1−𝛼𝛼/2,𝑑𝑑,𝑑𝑑 .

Power
The power of this combination of tests is given by
Power = P�𝑅𝑅1�𝐹𝐹𝛼𝛼/2,𝑑𝑑,𝑑𝑑 � � + 1 − P�𝐹𝐹 < 𝑅𝑅1�𝐹𝐹1−𝛼𝛼/2,𝑑𝑑,𝑑𝑑 � �

where F is the common F distribution with the indicated degrees of freedom, 𝛼𝛼 is the significance level, and R1 is
the actual variance ratio.
A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary
sample size.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal variances when in fact the variances are unequal.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
variances when in fact the variances are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Sequence Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for
both sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
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•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Sequence 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then
PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Sequence 2)
This option is displayed if Sequence Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g.,
N1 = 10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for N1 and N2.
Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
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Sample Size (When Not Solving for Sample Size)
Sequence Allocation
Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence
sample size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Sequence 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Sequence
This option is displayed only if Sequence Allocation = “Equal (N1 = N2).”
The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same
in each sequence, this value is the value for N1, and also the value for N2.
The Sample Size Per Sequence must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Sequence 1)
This option is displayed if Sequence Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2
= R * N1.”
N1 is the number of items or individuals sampled from the Sequence 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Sequence 2)
This option is displayed only if Sequence Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage
of the total sample size in Sequence 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample
size needs to be at least 4.
You can enter a single value or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
M (Number of Replicates)
Enter one or more values for M: the number of replicates in a 2 × 2M replicated cross-over design. M is the
number of times each treatment is measured on each subject.
For example, M = 2 refers to a 2 × 4 replicated cross-over design. The two sequences used for this design are
often
Sequence 1: R T R T
Sequence 2: T R T R.
You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.
The range is M ≥ 2.

Effect Size
R1 (Actual Variance Ratio)
Enter one or more values for within-subject variance ratio assumed by the alternative hypothesis. This is the value
of σ²ᴡᴛ / σ²ᴡᴄ at which the power is calculated.
This value should be greater than zero. It cannot be equal to one.
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that it is has a different
within-subject variance from the standard drug. A 2 x 4 cross-over design will be used.
Company researchers set the significance level to 0.05, the power to 0.90, and the alternative variance ratios
between 0.5 and 2.0. They want to investigate the range of required sample size values assuming that the two
sequence sample sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Within-Subj Variances in a 2×2M Rep. Cross-Over Design
procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
M (Number of Replicates) ....................... 2
R1 (Actual Variance Ratio) ..................... 0.5 0.66667 0.8 1.25 1.5 2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Actual
Power
0.9049
0.9015
0.9003
0.9003
0.9015
0.9049

Sequence 1
Sample
Size
N1
46
130
424
424
130
46

Sequence 2
Sample
Size
N2
46
130
424
424
130
46

N
92
260
848
848
260
92

Number of
Replicates
M
2
2
2
2
2
2

Actual
Variance
Ratio
R1
0.500
0.667
0.800
1.250
1.500
2.000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons.
Hoboken, New Jersey.
Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the number of subjects in sequence 1.
N2 is the number of subjects in sequence 2.
N is the total number of subjects. N = N1 + N2.
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a
subject.
R1 is the value of the within-subject variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.
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Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to assess the inequality of within-subject variability of two groups
by looking at the ratio of their variances. If the sample variance ratio is too large or too
small, the group variabilities are concluded to be unequal. Sequence sample sizes of 46 and 46
achieve 90% power to reject the null hypothesis of equality at a significance level of 0.050.
The variance ratio at which the power is calculated is assumed to be 0.500. The number of times
each treatment measurement is repeated on a subject is 2.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and R1.
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Example 2 – Validation using Chow and Liu (2014)
We will use an example from Chow and Liu (2014) page 509 to validate this procedure.
In this example, the significance level to 0.05, M is 2, the power is 0.80, and the actual variance ratio is 0.3/0.45
or about 0.667. The resulting sample size is found to be 98 per sequence.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Within-Subj Variances in a 2×2M Rep. Cross-Over Design
procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
M (Number of Replicates) ....................... 2
R1 (Actual Variance Ratio) ..................... 0.667

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Actual
Power
0.8032

Sequence 1
Sample
Size
N1
98

Sequence 2
Sample
Size
N2
98

N
196

Number of
Replicates
M
2

Actual
Variance
Ratio
R1
0.667

Alpha
0.050

The sample size matches Chow and Liu (2014).
Note that the result depends on the amount of rounding that is applied to R1. If R1 = 0.67, then N1 = 100. But if
R1 = 0.66667, then N1 = 97.
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